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Abstract 
 

  

These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 11.1 and Avaya Session 

Border Controller for Enterprise Release 8.1 to support Avaya SIP Trunking Service using UDP 

transport on the public side. 

 

The Avaya SIP Trunking service offer referenced within these Application Notes provides 

customers with PSTN access via a SIP trunk between the enterprise and the service provider 

network. The service provides local and/or long distance PSTN calling via standards-based SIP 

trunks directly as an alternative to legacy analog or digital trunks. The Avaya SIP Trunking 

service provides you with a cost effective and flexible way to connect your business to the 

outside world. It helps your business use the internet bandwidth you already pay for in a more 

flexible way. 

 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 

Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases 

are adequately covered by this scope and results. 
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1. Introduction 
These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking Service between the Avaya SIP Trunking service offering and a simulated Avaya 

enterprise solution. User Datagram Protocol (UDP) transport was used to connect the simulated 

enterprise solution to the Avaya SIP Trunking service offering (public side network side). 

 

In the configuration used during the testing, the simulated Avaya enterprise solution consists of 

an Avaya IP Office Server Edition, two Avaya IP Office 500 V2 as expansion systems, running 

software release 11.1 (hereafter referred to as IP Office), an Avaya Session Border Controller for 

Enterprise Release 8.1 (hereafter referred to as Avaya SBCE) and various Avaya endpoints, 

listed in Section 4. 

 

The terms “Avaya network” or “service provider” will be used interchangeably throughout these 

Application Notes to represent the far-end/service provider side of the Avaya SIP Trunking 

service offering handling calls to/from the PSTN across the SIP trunk. The terms “enterprise” or 

“Avaya enterprise” will be used interchangeably throughout these Application Notes to represent 

the Customer-Premises-Equipment site containing all the equipment for the Avaya enterprise 

solution. 

2. General Test Approach and Test Results  
A simulated CPE site containing all the equipment for the Avaya enterprise solution was 

installed at the Avaya Solution and Interoperability Lab. The enterprise site was configured to 

connect to the Avaya network via a broadband connection to the public Internet. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in this Application Note 

included the enablement of supported encryption capabilities in the Avaya products only (private 

network side). Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 

 

For the testing associated with this Application Note, the interface between the simulated 

enterprise site (private network) and the Avaya network (public network) did not include the use 

of any specific encryption features, UDP/RTP was used. 

 

Encryption (TLS/sRTP) was used internal to the enterprise between Avaya products wherever 

possible. 

2.1. Interoperability Compliance Testing 

To verify SIP trunk interoperability the following features and functionalities were exercised 

during the interoperability compliance test: 

• Public DNS “SRV” record queries to establish the SIP trunk connections across multiple 

servers. 

• SIP Trunk Registration (Dynamic Authentication). 

• Response to SIP OPTIONS queries. 
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• Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, Digital and 

Analog telephones at the enterprise. All incoming calls from the PSTN were routed to the 

enterprise across the SIP trunk from the service provider’s network. 

• Outgoing PSTN calls from Avaya endpoints, including SIP and H.323, Digital and 

Analog telephones at the enterprise. All outgoing calls to the PSTN were routed from the 

enterprise across the SIP trunk to the service provider’s network. 

• Inbound and outbound PSTN calls to/from Remote Workers using the Avaya Workplace 

Client for Windows SIP softphone. 

• Caller ID presentation. 

• Proper disconnect when the caller abandons the call before the call is answered. 

• Proper disconnect via normal call termination by the caller or the called parties. 

• Proper disconnect by the network for calls that are not answered (with coverage to 

voicemail off). 

• Proper response to busy endpoints. 

• Proper response/error treatment when dialing invalid PSTN numbers.  

• Proper codec negotiation and two-way speech-path. Testing was performed with codecs: 

G.711MU, G.711A and G.729(a), Avaya preferred codec order. 

• Proper response to no matching codecs. 

• Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail 

messages, etc.). 

• Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems). 

• Call Hold/Resume (long and short duration). 

• Call Forward (unconditional, busy, no answer).  

• Blind Call Transfers. 

• Consultative Call Transfers. 

• Station Conference. 

• Mobility twinning of incoming calls to mobile phones. 

• Simultaneous active calls. 

• Long duration calls (over one hour). 

• Proper response/error treatment to all trunks busy. 

• Proper response/error treatment when disabling SIP connection. 

• T.38 fax. 

• SIP REFER method for call re-direction from the enterprise to the PSTN. 

 

Note: Remote Worker was tested as part of this solution. The configuration necessary to support 

remote workers is beyond the scope of these Application Notes and is not included in these 

Application Notes. 
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Items that were not tested for not being available at the time of testing includes the following: 

• 0, 0+10 digits and 411 calls were not tested. 

2.2.  Test Results 

Interoperability testing of Avaya SIP Trunking Service was completed with successful results for 

all test cases with the exception of the observations/limitations described below. 

• T.38 Fax  –  IP Office negotiates the use of T.38 for fax by sending a re-INVITE message 

with two media lines in the SDP, with the first media line set for audio, with the port set 

to 0, and the second media line set for T.38, with a valid port number, thus de-activating 

audio transmission for the call. The Service Provider responded to this re-INVITE message 

sent by Avaya IP Office with "488 Not Acceptable Here". With IP Office configured to use 

T.38, the "488 Not Acceptable Here" response sent by the Service Provider did not have any 

impact on the fax transmission, both, inbound and outbound fax were successful transmitted 

via T.38. It’s being mentioned here simply as an observation. The setting of T.38 Fall-Back 

in IP Office caused fax transmissions to fail intermittently, thus only the setting of T.38 is 

recommended for fax transmission. 

• SIP Trunk registrations – After each successful SIP Trunk registration attempt the 

service provider would send a “484 Address Incomplete” message response to the 

enterprise. This behaviour did not have any service impact, registrations were successful, 

it’s being mentioned here simply as an observation. 

• SIP OPTION Messages – During the compliance test Avaya did not send SIP OPTION 

messages to IP Office, IP Office did send SIP OPTION messages to Avaya, this was 

sufficient to keep the SIP trunk up in-service. 

• SIP endpoints may indicate that a transfer failed even when it is successful – 

Occasionally on a transfer operation, Avaya IP Office SIP endpoints (Avaya 1100 Series 

Deskphones) may indicate on the local call display that the transfer failed even though it 

was successful. The frequency of this behavior can be reduced by enabling “Emulate 

Notify for REFER” on the IP Office SIP Line (Section 5.5.6). 

2.3. Support 

For information on Avaya SIP Trunking service go to: https://www.avaya.com/en/documents/fs-

sip-uc8179en.pdf 
 

For technical support on the Avaya products described in these Application Notes visit 

http://support.avaya.com 

 

https://www.avaya.com/en/documents/fs-sip-uc8179en.pdf
https://www.avaya.com/en/documents/fs-sip-uc8179en.pdf
http://support.avaya.com/
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3. Reference Configuration 
Figure 1 illustrates the sample Avaya enterprise solution connected to the Avaya SIP Trunking 

service through the public Internet. 

 

The Avaya components used to create the simulated enterprise customer site includes: 

• IP Office Server Edition running in VMware environment. 

− Avaya IP Office Voicemail Pro. 

• Two Avaya IP Office 500 V2 as expansion systems. 

• Avaya Session Border Controller for Enterprise. 

• Avaya 96x1 Series IP Deskphones (H.323). 

• Avaya J179 IP Deskphones (H.323). 

• Avaya 1100 Series IP Deskphones (SIP). 

• Avaya J129 IP Deskphones (SIP). 

• Avaya 1400 Series Digital Deskphones. 

• Analog Deskphones. 

• Avaya Workplace Client for Windows (SIP).  

 

Avaya IP Office provides the voice communications services for the enterprise. In the reference 

configuration, Avaya IP Office runs on the Avaya IP Office Server Edition platform. Note that 

this solution is extensible to deployments using the standalone IP500 V2 platform as well. 

 

In the sample configuration, the Primary server runs the Avaya IP Office Server Edition Linux 

software. Avaya Voicemail Pro runs as a service on the Primary Server. The LAN1 port of the 

Primary Server is connected to the enterprise LAN. The LAN2 port was not used. 

 

The Expansion Systems (IP500 V2) were used for the support of digital, analog and additional IP 

stations. The Avaya IP Office 500 V2 is equipped with analog and digital extension expansion 

modules, as well as a VCM64 (Voice Compression Module). The LAN1 ports of the Avaya IP 

Office IP500 V2 systems are connected to the enterprise LAN, the LAN2 ports were not used.  

 

Located at the edge of the enterprise is the Avaya SBCE. The Avaya SBCE has two physical 

interfaces, interface B1 is used to connect to the public network, interface A1 is used to connect 

to the private network. All SIP and RTP traffic entering or leaving the enterprise flows through 

the Avaya SBCE. The Avaya SBCE provides network address translation at both the IP and SIP 

layers. 

 

IP endpoints at the enterprise included Avaya 96x1 Series IP Deskphones (with H.323 

firmware), Avaya 1100 Series IP Deskphones (with SIP firmware), Avaya J100 Series IP 

Deskphones (with SIP and H.323 firmware), Avaya Workplace Client for Windows (SIP) Avaya 

Digital and Analog Deskphones. IP endpoints were registered to the Primary Server; non-IP 

endpoints (analog and digital) were registered to the Expansion Systems. The site also has a 

Windows PC running Avaya IP Office Manager to configure and administer the system. Mobile 

Twinning is configured for some of the IP Office users so that calls to these user’s extensions 

will also ring and can be answered at the configured mobile phones.  
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The transport protocol between the Avaya SBCE and Avaya, across the public Internet, is SIP 

over UDP. The transport protocol between the Avaya SBCE and IP Office, across the enterprise 

private IP network, is SIP over TLS. 

 

For inbound calls, the calls flowed from Avaya network to the Avaya SBCE, then to IP Office.  

 

Outbound calls to the PSTN were first processed by IP Office. Once IP Office selected the 

proper SIP trunk, the call was routed to the Avaya SBCE for egress to Avaya network. 

 

For the compliance test, users dialed a short code of 9 + N digits to make calls across the SIP 

trunk to Avaya network. The short code 9 was stripped off by Avaya IP Office but the remaining 

N digits were sent unaltered to Avaya network. 

 

In an actual customer configuration, the enterprise site may include additional network 

components between the service provider and the IP Office system, such as a session border 

controller or data firewall. A complete discussion of the configuration of these devices is beyond 

the scope of these Application Notes. However, it should be noted that all SIP and RTP traffic 

between the service provider and the IP Office system must be allowed to pass through these 

devices. 

 

For confidentiality and privacy purposes, public IP addresses, domain names, and routable DID 

numbers used during the compliance testing have been masked. 
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Figure 1: Avaya simulated enterprise site connected to the Avaya SIP Trunking service 

offering 
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4. Equipment and Software Validated 
The following equipment and software were used for the sample configuration provided: 

 

Equipment/Software Release/Version 

Avaya 

Avaya IP Office Server Edition (Primary Server) 

• Avaya IP Office Voicemail Pro 

11.1.0.1 Build 95 

11.1.0.1 Build 10 

Avaya IP Office IP500 V2 (Expansion Systems) 11.1.0.1 Build 95 

Avaya IP Office Manager 11.1.0.1 Build 95 

Avaya Session Border Controller for Enterprise  ASBCE 8.1 

8.1.1.0-26-19214 

Avaya 96x1 Series IP Deskphones (H.323) 6.8304 

Avaya J179 IP Telephone (H.323) 6.8304 

Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00 

Avaya J129 IP Deskphones (SIP) 4.0.6.0.8 

Avaya 1408 Digital Telephone 48.02 

Avaya Workplace Client for Windows (SIP) 3.11.0.44.25 

Analog Telephone --- 

 

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP 

Office 500 V2 and also when deployed with all configurations of IP Office Server Edition. IP 

Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital 

endpoints. 
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5. Avaya IP Office Primary Server Configuration 
Avaya IP Office is configured through the Avaya IP Office Manager application. From the PC 

running the IP Office Manager application, select Start → Programs → IP Office → Manager 

to launch the Manager application. Log in using the appropriate credentials. 
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On Server Edition systems, the Solution View screen will appear, similar to the one shown 

below. All the Avaya IP Office configurable components are shown in the left pane, known as 

the Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g., 

IPOSE-Primary, on the navigation pane will expand the menu on this server. 
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In the screens presented in the following sections, the View menu was configured to show the 

Navigation pane on the left side and the Details pane on the right side. These panes will be 

referenced throughout the rest of this document.  

 

Standard feature configurations that are not directly related to the interfacing with the service 

provider are assumed to be already in place, and they are not part of these Application Notes. 

5.1. Licensing  

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative. 

 

In the reference configuration, IPOSE-Primary was used as the system name of the Primary 

Server, IP500V2-One and IP500V2-Two were used as the system name for the two Expansion 

Systems. All navigation described in the following sections (e.g., License) appears as submenus 

underneath the system name in the Navigation Pane.  

 

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status 

for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the 

number of channels provisioned for the SIP trunk. 
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5.2. TLS Management 

For the compliance test, the signaling on the SIP trunk between IP Office and the Avaya SBCE 

was secured using TLS. Testing was done using identity certificates signed by a local certificate 

authority, Avaya Aura® System Manager. The generation and installation of these certificates 

are beyond the scope of these Application Notes. However, once the certificates are available, 

they can be viewed on IP Office in the following manner. 

 

To view the certificates currently installed on IP Office, navigate to File → Advanced → 

Security Settings. Log in with the appropriate security credentials (not shown). In the Security 

Settings window, navigate to Security → System and select the Certificates tab. 

 

To verify the identity certificate, locate the Identity Certificate section and click View to see the 

details of the certificate. 
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5.3. System Settings  

Configure the necessary system settings. In an Avaya IP Office, the LAN2 tab settings 

correspond to the Avaya IP Office WAN port (public network side) and the LAN1 tab settings 

correspond to the LAN port (private network side). For the compliance test, the LAN1 interface 

was used to connect IP Office to the enterprise private network (LAN), LAN2 was not used. 

5.3.1. System – LAN1 Tab 

In the sample configuration, IPOSE-Primary was used as the system name, the LAN1 port 

connects to the inside interface (enterprise private network side) of the Avaya SBCE across the 

enterprise LAN (private) network. The outside interface of the Avaya SBCE connects to Avaya 

network via the public internet. To access the LAN1 settings, navigate to System (1) → IPOSE-

Primary in the Navigation Pane, then in the Details Pane navigate to the LAN1→ LAN Settings 

tab. The LAN1 settings for the compliance testing were configured with following parameters:  

• Set the IP Address field to the LAN IP address, e.g., 10.64.101.127. 

• Set the IP Mask field to the subnet mask of the enterprise private network, e.g., 

255.255.255.0. 

• All other parameters should be set according to customer requirements. 

• Click OK to commit (not shown). 
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5.3.1.1 LAN1 VoIP Tab 

The VoIP tab as shown in the screenshot below was configured with following settings: 

• Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the 

H.323 protocol to register. 

• Select Preferred under H.323 Signaling over TLS. When enabled, TLS is used to 

secure the registration and call signaling communication between IP Office and endpoints 

that support TLS. The H.323 phones that support TLS are 9608, 9611, 9621, 9641 

running firmware version 6.6 or higher and the Avaya J100 Series IP Deskphones. 

• Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to 

Avaya. 

• Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register 

using the SIP protocol. 

• Enter the Domain Name of the enterprise under SIP Domain Name. 

• Enter the SIP Registrar FQDN of the enterprise under SIP Registrar FQDN. 

• Check TLS and verify the TLS Port numbers under Layer 4 Protocol are set to 5061. 

• Verify the RTP Port Number Range settings for a specific range for the RTP traffic. 

The Port Range (Minimum) and Port Range (Maximum) values were kept as default. 

• In the Keepalives section at the bottom of the page, set the Scope field to RTP-RTCP, 

Periodic Timeout to 30, and Initial keepalives to Enabled. This will cause the IP Office 

to send RTP and RTCP keepalive packets at the beginning of the calls and every 30 

seconds thereafter if no other RTP/RTCP traffic is present.  

• All other parameters should be set according to customer requirements. 

• Click OK to commit (not shown). 
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5.3.1.2 LAN1 Network Topology tab 

The Network Topology tab as shown in the screenshot below was configured with following 

settings: 

• The Firewall/NAT Type was set to Open Internet in the reference configuration.  

• The Binding Refresh Time (sec) was set to 60 seconds. This is used to determine the 

frequency at which Avaya IP Office will send SIP OPTIONS messages, to periodically 

check the status of the SIP lines configured on this interface. The Public IP Address and  

• Public Port sections are not used. 
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5.3.2. System –Telephony Tab 

To access the System Telephony settings, navigate to the Telephony → Telephony tab in the 

Details pane, configure the following parameters:  

• Choose the Companding Law typical for the enterprise location; U-Law was used for 

the compliance test. 

• Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and 

call transfer to the PSTN. If for security reasons incoming calls should not be allowed to 

transfer back to the PSTN then leave this setting checked.  

• All other parameters should be set to default or according to customer requirements.  

• Click OK to commit (not shown). 
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5.3.3. System – VoIP Tab 

Navigate to the VoIP tab in the Details pane to view or change the system codecs and VoIP 

security settings. 

5.3.3.1 VoIP – VoIP Tab 

Select the VoIP → VoIP tab, configure the following parameters: 

• The RFC2833 Default Payload field allows for the manual configuration of the payload 

type used on SIP calls that are initiated by the IP Office. The default value 101 was used. 

• For codec selection, select the codecs and codec order of preference on the right, under 

the Selected column. The Default Codec Selection area enables the codec preference 

order to be configured on a system-wide basis. The buttons between the two lists can be 

used to move codecs between the Unused and Selected lists, and to change the order of 

the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323) 

will use the system default codec selection shown here, unless configured otherwise for a 

specific line or extension. The example below shows the codecs used for IP phones (SIP 

and H.323), the system’s default codecs and order were used. 

• Click OK to commit (not shown). 

 

 
 

Note: The codec selections defined under this section (VoIP – VoIP tab) are the codecs selected 

for the IP phones/extensions. The codec selections defined under Section 5.5.5 (SIP Line – VoIP 

tab) are the codecs selected for the SIP Line (Trunk). 
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5.3.3.2 VoIP – VoIP Security Tab 

Secure Real-Time Transport Protocol (SRTP) refers to the application of additional encryption 

and or authentication to VoIP calls (SIP and H.323). SRTP can be applied between telephones, 

between ends of an IP trunk or in various other combinations. 

 

Configuring the use of SRTP at the system level is done on the VoIP Security tab using the 

Media Security setting. The options are: 

• Disabled (default). 

• Preferred. 

• Enforced. 

 

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP 

Office uses SRTP if supported by the far-end, otherwise uses RTP. If the Enforced setting is 

used, and SRTP is not supported by the far-end, the call is not established. 

 

To configure the use of SRTP, select the VoIP → VoIP Security tab on the Details pane.  

• Set the Media Security drop-down menu to Preferred to have IP Office attempt use 

encrypted RTP for devices that support it and fall back to RTP for devices that do not 

support encryption.  

• Verify Strict SIPS is not checked. 

• Under Media Security Options, select RTP for the Encryptions and Authentication 

fields.  

• Under Crypto Suites, select SRTP_AES_CM_128_SHA1_80.  

• Click OK to commit (not shown). 
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5.4. IP Route 

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to 

send the packets in order to route calls to Avaya network.  

 

Navigate to IP Route, right-click on IP Route and select New. The values used during the 

compliance test are shown below: 

• Set the IP Address and IP Mask to 0.0.0.0 to make this the default route. 

• Set Gateway IP Address to the IP address of the gateway/router used to route calls to the 

public network, e.g., 10.64.101.1. 

• Set Destination to LAN1 from the pull-down menu. 

• Click OK to commit (not shown). 
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5.5. SIP Line  

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Avaya SIP 

Trunking Service. The recommended method for configuring a SIP Line is to use the template 

associated with these Application Notes. The template is an .xml file that can be used by IP 

Office Manager to create a SIP Line. Follow the steps in Sections 5.5.1 to create the SIP Line 

from the template. 

 

Some items relevant to a specific customer environment are not included in the template or may 

need to be updated after the SIP Line is created. Examples include the following: 

• IP addresses 

• SIP Credentials (if applicable) 

• SIP URI entries 

 

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary, 

after the SIP Line is created via the template. The resulting SIP Line data can be verified against 

the manual configuration shown in Section 5.5.2 to 5.5.6. 

 

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the 

Navigation pane and select New → SIP Line. Then, follow the steps outlined in Sections 5.5.2 

to 5.5.6. 

5.5.1. Creating a SIP Trunk from an XML Template 

SIP Line templates are always exported in an XML format. These XML templates do not include 

sensitive customer specific information and are therefore suitable for distribution. The XML 

format templates can be used to create SIP trunks on both IP Office Standard Edition (500 V2) 

and IP Office Server Edition systems. Alternatively, binary templates may be generated. 

However, binary templates include all the configuration parameters of the Trunk, including 

sensitive customer specific information. Therefore, binary templates should only be used for 

cloning trunks within a specific customer’s environment. 

 

Copy a previously created template file to a location (e.g., \Temp) on the same computer where 

IP Office Manager is installed.  
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To create the SIP Trunk from the template, from the Primary server, right-click on Line in the 

Navigation Pane, then navigate to New → New from Template→Open from file. 
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Navigate to the directory on the local machine where the template was copied and select the 

template. 

 

 
 

After the import is complete, a final import status pop-up window will open stating success or 

failure. Click OK. 

 

 
 

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17). 
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It is important that the SIP Line configuration be reviewed and updated if necessary, after the 

SIP Line is created via the template. The resulting SIP Line data can be verified against the 

manual configuration shown in Sections 5.5.2 to 5.5.6. 

5.5.2. SIP Line – SIP Line Tab 

The SIP Line tab in the Details pane is shown below for Line Number 17, configure or verify 

the parameters as shown below: 

• Leave the ITSP Domain Name blank. Note that if this field is left blank, then IP Office 

inserts the ITSP Proxy Address from the Transport tab as the ITSP Domain in the SIP 

messaging. 

• Local Domain Name is set to the IP address of the Avaya IP Office LAN1 interface 

(e.g., 10.64.101.127). 

• Verify that In Service box is checked, the default value. This makes the trunk available 

to incoming and outgoing calls. 

• Verify that Check OOS box is checked, the default value. IP Office will use the SIP 

OPTIONS method to periodically check the SIP Line. 

• Verify that Refresh Method is set to Auto. 

• Verify that Timer (sec) is set to On Demand. 

• Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing 

Supervised REFER to Always (SIP REFER is supported by the Service Provider). 

• Check Outgoing Blind REFER parameter to enable the use of REFER for blind 

transfers. 

• Click OK to commit (not shown). 
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5.5.3. SIP Line – Transport Tab 

Select the Transport tab. Set or verify the parameters as shown below: 

• Set the ITSP Proxy Address to the inside IP Address of the Avaya SBCE or 

10.64.101.243 as shown in Figure 1. 

• Set Layer 4 Protocol to TLS. 

• Set Use Network Topology Info to None (see note below).  

• Set the Send Port to 5061. 

• Default values may be used for all other parameters. 

• Click OK to commit (not shown). 

 

 
 

Note: For the compliance testing, the Use Network Topology Info field was set to None, since 

no NAT was used in the test configuration.  If a NAT is used between Avaya IP Office and the 

other end of the trunk, then the Use Network Topology Info field should be set to the LAN 

interface (LAN1) used by the trunk and the System → LAN1 → Network Topology tab needs 

to be configured with the details of the NAT device. 
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5.5.4. SIP Line – Call Details Tab 

Select the Call Details tab, and then click the Add… button (not shown) and the screen shown 

below will appear. To edit an existing entry, click an entry in the list at the top, and click the 

Edit… button. In the example screen below two new entries were added, one for incoming calls 

and one for outgoing calls.  

• Associate this line with an incoming line group by entering a line group number in the 

Incoming Group field. This line group number will be used in defining incoming call 

routes for this line. Similarly, associate the line to an outgoing line group using the 

Outgoing Group field. The outgoing line group number is used in defining short codes 

for routing outbound traffic to this line. For the compliance test, a new incoming and 

outgoing group 17 was defined that only contains this line (line 17).  

• Under Credentials, select 0: <None> from the pull-down menu. 

• Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP 

URI pattern. 

• Check the P Asserted ID and Diversion Header.  

• Set the Local URI, Contact, P Asserted ID and Diversion Header fields to the values 

shown in the screenshot below. 

• Set all remaining fields as shown on the screenshot below.  

• Click OK. 
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5.5.5. SIP Line – VoIP Tab 

Select the VoIP tab, to set the Voice over Internet Protocol parameters of the SIP Line. Set or 

verify the parameters as shown below: 

• The Codec Selection was configured using the Custom option, allowing an explicit 

order of codecs to be specified for the SIP Line. The buttons allow setting the specific 

order of preference for the codecs to be used on the SIP Line, as shown. Avaya supports 

codecs G.711ULAW, G.711ALAW and G.729(a) for audio. 

• Select T38 for Fax Transport Support (Refer to Section 2.2). 

• Set the DTMF Support field to RFC2833/RFC4733. This directs Avaya IP Office to 

send DTMF tones using RTP events messages as defined in RFC2833. 

• Set the Media Security field to Same as System (Preferred). 

• Check the Re-invite Supported box.  

• Check the PRACK/100rel Supported box  

• Default values may be used for all other parameters. 

• Click the OK to commit (not shown). 
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Note: The codec selections defined under this section are the codecs selected for the SIP Line 

(Trunk). The codec selections defined under Section 5.3.3 are the codecs selected for the IP 

phones/extension (H.323 and SIP). 

5.5.6. SIP Line – SIP Advanced Tab 

In the Addressing area: 

• Select To Header for Call Routing Method. 

 

In the Identity area: 

• Check the box for Use PAI for Privacy. 

 

In the Call Control area: 

• Check Emulate NOTIFY for REFER (Refer to Section 2.2). 

• Default values may be used for all other parameters. 

• Click OK to commit (not shown). 
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5.6. Users 

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP 

Line defined in Section 5.5. To configure these settings, first navigate to User → Name in the 

Navigation Pane where Name is the name of the user to be modified. In the example below, the 

name of the user is Ext3041 H323. Select the SIP tab in the Details Pane. The SIP Name and 

Contact are set to one of the DID numbers assigned to the enterprise by Avaya. Note the DID 

number is preceded by +1 since its required in order to conform with the E.164 numbering 

format. The SIP Display Name (Alias) parameter can optionally be configured with a 

descriptive name. If all calls involving this user and a SIP Line should be considered private, 

then the Anonymous box may be checked to withhold the user’s information from the network. 

This can also be accomplished by activating Withhold Number on H.323 Deskphones (not 

shown). Click the OK to commit (not shown). 
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5.7. IP Office Line – Primary Server 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the IP500V2-One Expansion 

System. 
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The screen below shows the IP Office Line, VoIP Settings tab:  

• Under Codec Selection verify System Default is selected (default value). 

• Select T38 for Fax Transport Support (refer to Section 2.2). 

• Under Media Security verify Same as System (Preferred) is selected (default value). 

 

 
 

Repeat this process as needed to add additional Secondary server or Expansion Systems to the 

solution. 
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5.8. Incoming Call Route 

Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt 

groups, short codes, etc., within the IP Office system. To add an incoming call route, right click 

on Incoming Call Route in the Navigation pane and select New (not shown). On the Details 

Pane, under the Standard tab, set the parameters as show below: 

• Set Bearer Capacity to Any Voice.  

• The Line Group ID is set to 17. This matches the Incoming Group field configured in 

the Call Details tab for the SIP Line on Section 5.5.4. 

• On the Incoming Number, enter one of the DID numbers provided by Avaya. Note the 

DID number is preceded by +1 since its required in order to conform with the E.164 

numbering format. 

• Default values may be used for all other parameters. 

• Click OK to commit (not shown). 
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Select the Destinations tab. From the Destination drop-down menu, select the IP Office 

extension associated with this DID number. In the reference configuration, the DID number 

+12134101011 provided by Avaya was associated with the Avaya IP Office extension 3041. 

 

 
 

Repeat this process as needed to assign incoming call routes to additional IP Office users, as well 

as for other Avaya IP Office destinations (Hunt Group, Voicemail, Short Codes, etc.). 
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5.9. Outbound Call Routing 

For outbound call routing, a combination of system short codes and Automatic Route Selection 

(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing 

can be specified so that a call can re-route automatically if the primary route or outgoing line 

group is not available. While detailed coverage of ARS is beyond the scope of these Application 

Notes, and alternate routing was not used in the reference configuration, this section includes 

some basic screen illustrations of the ARS settings used during the compliance testing. 

5.9.1. Short Codes and Automatic Route Selection 

To create a short code to be used for ARS, right-click on Short Code, the Navigation pane and 

select New. The screen below shows the short code 9N created (note that the semi-colon is not 

used here). In this case, when the IP Office user dials 9 plus any number N, instead of being 

directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is 

configurable via ARS. 

• In the Code field, enter the dial string which will trigger this short code. In this case, 9N 

was used (note that the semi-colon is not used here). 

• Set Feature to Dial. This is the action that the short code will perform. 

• Set Telephone Number to N. The value N represents the number dialed by the user after 

removing the 9 prefix. This value is passed to ARS. 

• Set the Line Group ID to 50: Main to be directed to Line Group 50: Main, this is 

configurable via ARS. 

• For Locale, United States (US English) was used. 

• Click the OK to commit (not shown). 
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As described above, Short Code 9N was defined for ARS access. Therefore, outbound calls via 

ARS are dialed as 9 plus the number. ARS will strip off the 9, and it will process the call based 

on the remaining digits. ARS 50: Main shown below was used during the compliance test. 

 

Select ARS → 50: Main on the Navigation Pane and click Add. 
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Configure the following parameters: 

• In the Code field, enter the dial string which will trigger this short code. In this case, 1 

followed by 10 Xs to represent the exact number of digits. 

• Set Feature to Dial. This is the action that the short code will perform. 

• Set Telephone Number to +1N. The value N represents the additional number of digits 

dialed by the user after dialing 1 (The 9 will be stripped off). With this setting, the 10 

digit dialed number, preceded by prefix +1 will be sent to the SIP trunk, required to 

conform with the  E.164 numbering format. 

• Set the Line Group Id to the Line Group number being used for the SIP Line, in this 

case Line Group ID 17 was used. 

• For Locale, United States (US English) was used. 

• Click OK to commit. 

 

The following example shows the dial pattern for calls within the North American Numbering 

Plan. 

 

 
 

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out 

from IP Office. 
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5.10. Save IP Office Primary Server Configuration 

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP 

Office server in order for the changes to take effect. At the top of the Avaya IP Office Manager 

page, click File → Save Configuration (if that option is grayed out, no changes are pending).  

 

A screen similar to the one below will appear, with either Merge or Reboot automatically 

selected, based on the nature of the configuration changes. The Merge option will save the 

configuration change with no impact to the current system operation. The Reboot option will 

save the configuration and cause the Avaya IP Office server to reboot.  

 

Click OK to execute the save. 
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6. Avaya IP Office Expansion System Configuration 
Navigate to File → Open Configuration (not shown), select the proper Avaya IP Office system 

from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign 

next to IP500V2-One on the left navigation pane will expand the menu on this server. 
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6.1. Expansion System – Physical Hardware 

In the sample configuration, the IP500 V2 Expansion System contained a PHONE8 analog card, 

for the support of analog extensions, a DIG DCPx16 V2, for support of digital extensions. Also 

included is a VCM64 (Voice Compression Module). The VCM64 cards provide voice 

compression channels to the control unit. Voice compression channels are needed to support 

VoIP calls, including IP extensions and or IP trunks. 
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6.2. Expansion System – LAN Settings 

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise 

network. To view or configure the LAN1 IP address, select System on the Navigation pane. 

Select the LAN1 → LAN Settings tab on the Details pane, and enter the following:  

• IP Address: 192.168.128.165 was used in the reference configuration.  

• IP Mask: 255.255.255.0 was used in the reference configuration  

• Click the OK button (not shown).  

 

 
 

Default values were used on the VoIP and Network Topology tabs (not shown). 
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6.3. Expansion System – IP Route 

To create an IP route for the Expansion system, right-click on IP Route on the left Navigation 

pane. Select New (not shown). 

• Enter 0.0.0.0 on the IP Address and IP Mask fields to make this the default route. 

• Set Gateway IP Address to the IP Address of the default router in the IP Office subnet. 

The default gateway in the reference configuration was 192.168.128.200. 

• Set Destination to LAN1 from the pull-down menu. 
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6.4. Expansion System – IP Office Line 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the Primary server. 
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The screen below shows the IP Office Line, VoIP Settings tab:  

• Under Codec Selection verify System Default is selected (default value). 

• Select T38 for Fax Transport Support (refer to Section 2.2). 

• Under Media Security Preferred was selected. 
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The screen below shows the IP Office Line, T38 Fax tab: 

• Uncheck the Use Default Values at the bottom of the screen. 

• Set the T.38 Fax Version to 0. 

• Default values may be used for all other parameters. 

• Click the OK to commit (not shown). 
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6.5. Expansion System – Short Codes 

Similar to the configuration of the Primary server in Section 5.9.1, create a Short Code to access 

ARS. In the reference configuration, the Line Group ID is set to the ARS route illustrated in the 

next section. 
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6.6. Expansion System Automatic Route Selection – ARS 

The following screen shows an example ARS configuration for the route named “To-Primary” 

on the Expansion System. The Telephone Number is set to 9N. The Line Group ID is set to 

“99999” matching the number of the Outgoing Group ID configured on the IP Office Line 17 to 

the Primary server (Section 6.4). 

 

 
 

Repeat this process as needed to add additional Secondary server or Expansion Systems to the 

solution. 
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6.7. Save Expansion System Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections 

 

The following will appear, with either Merge or Reboot selected, based on the nature of the 

configuration changes made since the last save. Note that clicking OK may cause a service 

disruption. Click OK to proceed. 
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7. Configure Avaya Session Border Controller for Enterprise  
This section describes the configuration of the Avaya SBCE. It is assumed that the initial 

installation of the Avaya SBCE, the assignment of the management interface IP Address and 

license installation have already been completed; hence these tasks are not covered in these 

Application Notes. For more information on the installation and initial provisioning of the Avaya 

SBCE consult the Avaya SBCE documentation in the References section. 

 

Some screens capture will show the use of the Edit command instead of the add command, since 

the configuration used for the testing was previously added. 

 

Note: In the following pages, and for brevity in these Application Notes, not every provisioning 

step will have a screenshot associated with it. Some of the default information in the screenshots 

that follow may have been cut out (not included) for brevity. 

7.1. Log in Avaya SBCE 

Use a Web browser to access the Avaya SBCE Web interface. Enter https://<ip-addr>/sbc in the 

address field of the web browser, where <ip-addr> is the Avaya SBCE management IP address. 

 

Enter the appropriate credentials and click Log In. 
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Once logged in, on the top left of the screen, under Device: select the device being managed, 

Avaya_SBCE in the sample configuration.  

 

 
 

The left navigation pane contains the different available menu items used for the configuration of 

the Avaya SBCE. Verify that the status of the License State field is OK, indicating that a valid 

license is present. Contact an authorized Avaya sales representative if a license is needed.  
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7.2. Device Management 

To view current system information, select Device Management on the left navigation pane. In 

the reference configuration, the device named Avaya_SBCE is shown. The management IP 

address that was configured during installation is blurred out for security reasons; the current 

software version is shown. The management IP address needs to be on a subnet separate from the 

ones used in all other interfaces of the Avaya SBCE, segmented from all VoIP traffic. Verify that 

the Status is Commissioned, indicating that the initial installation process of the device has been 

previously completed, as shown on the screen below. 
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To view the network configuration assigned to the Avaya SBCE, click View on the previous 

above. The System Information window is displayed, containing the current device 

configuration and network settings. Note that DNS configuration is required for this solution. 

The DNS information can be added by clicking on Edit shown on the previous screen. 

 

 
 

The IP addresses in the System Information screen shown above are the ones used for the SIP 

trunk to the service provider and are the ones relevant to these Application Notes. The other IP 

addresses assigned to the Avaya SBCE A1 and B1 interfaces that are blurred out are used to 

support remote workers and other SIP trunks, and they are not discussed in this document. Also 

note that for security purposes, any public IP addresses used during the compliance test have 

been masked in this document. 

 

In the reference configuration, the private interface of the Avaya SBCE (10.64.101.243) was 

used to connect to the enterprise network, while its public interface (10.10.80.51) was used to 

connect to the public network. See Figure 1. 
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On the License Allocation area of the System Information, verify that the number of Standard 

Sessions is sufficient to support the desired number of simultaneous SIP calls across all SIP 

trunks at the enterprise. The number of sessions and encryption features are primarily controlled 

by the license file installed. 

7.3.  TLS Management 

Note: Testing was done with System Manager signed identity certificates. The procedure to 

create and obtain these certificates is outside the scope of these Application Notes. 

 

In the reference configuration, TLS transport is used for the communication between IP Office 

and Avaya SBCE. The following procedures show how to create the client and server profiles to 

support the TLS connection. 

7.3.1. Verify TLS Certificates – Avaya Session Border Controller for 
Enterprise 

Once logged in, on the top left of the screen, under Device: select the device being managed, 

Avaya_SBCE in the sample configuration. 
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Step 1 - Select TLS Management → Certificates from the left-hand menu. Verify the 

following: 

• System Manager CA certificate is present in the Installed CA Certificates area. 

• System Manager CA signed identity certificate is present in the Installed Certificates 

area. 

• Private key associated with the identity certificate is present in the Installed Keys area. 
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7.3.2. Server Profiles 

Step 1 - Select TLS Management → Server Profiles and click on Add. Enter the following: 

• Profile Name: enter descriptive name, e.g., IPO_Inside_Server. 

• Certificate: select the identity certificate, e.g., IPO_INSIDE.pem, from pull down 

menu. 

• Peer Verification = None. 

• Click Next. 

Step 2 - Accept default values for the next screen (not shown) and click Finish. 
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The following screen shows the completed TLS Server Profile form: 
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7.3.3. Client Profiles 

Step 1 - Select TLS Management → Client Profiles and click on Add. Enter the following: 

• Profile Name: enter descriptive name, e.g., IPO_Inside_Client. 

• Certificate: select the identity certificate, e.g., IPO_INSIDE.pem, from pull down 

menu. 

• Peer Verification = Required. 

• Peer Certificate Authorities: select the CA certificate used to verify the certificate 

received from Session Manager, e.g., default.pem. 

• Verification Depth: enter 1. 

• Click Next. 

Step 2 - Accept default values for the next screen (not shown) and click Finish. 
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The following screen shows the completed TLS Client Profile form: 
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7.4. Configuration Profiles 

The Configuration Profiles Menu, on the left navigation pane, allows the configuration of 

parameters across all Avaya SBCE appliances. 

7.4.1. Server Interworking – Avaya-IPO 

Interworking Profile features are configured to facilitate interoperability of implementations 

between enterprise SIP-enabled solutions and different SIP trunk service providers. 

 

Several profiles have been already pre-defined and they populate the list under Interworking 

Profiles on the screen below. If a different profile is needed, a new Interworking Profile can be 

created, or an existing default profile can be modified or “cloned”. Since directly modifying a 

default profile is generally not recommended, for the test configuration the default avaya-ru 

profile was duplicated, or “cloned”. If needed, the profile can then be modified to meet specific 

requirements for the enterprise SIP-enabled solution. For Avaya, this profile was left with the 

avaya-ru default values. 

 

On the left navigation pane, select Configuration Profiles → Server Interworking (not 

shown). From the Interworking Profiles list, select avaya-ru. Click Clone on top right of the 

screen (not shown). 

 

Enter the new profile name in the Clone Name field, the name of Avaya-IPO was chosen in this 

example. Click Finish. 
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Click Edit on the newly cloned Avaya-IPO interworking profile: 

• On the General tab, check T.38 Support.  

• Leave remaining fields with default values. 

• Click Finish. 
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The following screen capture shows the General tab of the newly created Avaya-IPO Server 

Interworking Profile. 
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The following screen capture shows the Advanced tab of the newly created Avaya-IPO Server 

Interworking Profile. 
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7.4.2. Server Interworking – SP-General 

A second Server Interworking profile named SP-General was created for the Service Provider. 

 

On the left navigation pane, select Configuration Profiles → Server Interworking (not 

shown). From the Interworking Profiles list, select Add (not shown) (note that Add is being 

used to create the SP-General profile instead of cloning the avaya-ru profile). 

 

Enter the new profile name, the name of SP-General was chosen in this example. 

• Click Next. 
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On the General tab, check T.38 Support, click Next until the last tab is reached then click 

Finish on the last tab leaving remaining fields with default values (not shown). 
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The following screen capture shows the General tab of the newly created SP-General Server 

Interworking Profile. 
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The following screen capture shows the Advanced tab of the newly created SP-General Server 

Interworking Profile. 

 

 

7.5. SIP Server Configuration 

SIP Server Profiles should be created for the Avaya SBCE’s two peers, the Call Server (IP 

Office) and the Trunk Server or SIP Proxy at the service provider’s network. 

 

To add the SIP Server profile for the Call Server, from the Services menu on the left-hand 

navigation pane, select SIP Servers (not shown). Click Add (not shown) and enter the profile 

name: IP Office-Thornton. 

• Click Next. 
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On the Edit SIP Server Profile – General window:   

• Server Type: Select Call Server. 

• IP Address / FQDN: 10.64.101.127 (IP Address of IP Office). 

• Port: 5061 (This port must match the port number defined in Section 5.3.1.1).  

• Transport: Select TLS. 

• Select a TLS Client Profile. 

• Click Next.  
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• Click Next until the Add SIP Server Profile - Advanced tab is reached (not shown). 

• On the Add SIP Server Profile - Advanced tab: 

• Verify that Enable Grooming is checked. 

• Select Avaya-IPO from the Interworking Profile drop down menu (Section 7.4.1). 

• Leave the Signaling Manipulation Script at the default None. 

• Click Finish.  

 

 
 

The following screen capture shows the General tab of the newly created IP Office-Thornton 

SIP Server Configuration Profile. 
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The following screen capture shows the Advanced tab of the newly created IP Office-Thornton 

SIP Server Configuration Profile. 

 

 
 

To add the SIP Server profile for the Trunk Server, from the Services menu on the left-hand 

navigation pane, select SIP Servers (not shown). Click Add (not shown) and enter the profile 

name: Service Provider UDP. 

• Click Next. 
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• On the Edit Server Configuration Profile - General Tab select Trunk Server from the 

drop-down menu for the Server Type. 

• Select SRV from the drop-down menu for DNS Query Type. 

• On the IP Addresses / FQDN field, enter svc1234.us-east.test.trunk.io (service 

provider’s SIP proxy server FQDN used for DNS SRV record queries). This information 

should be provided by the service provider.  

• Select UDP for Transport (note that the port cannot be enter since SRV was selected for 

DNS Query Type, the port being used will be collected from the DNS response). 

• Click Next (not shown). 
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On the Add SIP Server Profile - Authentication tab: 

• Check the Enable Authentication box.  

• Enter the User Name credential provided by the service provider for SIP trunk 

registration. 

• Leave the Realm blank. 

• Enter Password credential provided by the service provider for SIP trunk registration.  

• Click Next (not shown). 

 

 
 

Click Next on the Add Server Configuration Profile - Heartbeat window (not shown). 
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On the Add SIP Server Profile - Registration tab: 

• Check the Register with All Servers box (Register with Priority Server could also be 

used). 

• Frequency: Enter the amount of time (in seconds) between REGISTER messages that 

will be sent from the enterprise to the service provider Proxy Servers to refresh the 

registration binding of the SIP trunk. This value should be chosen in consultation with the 

service provider. 30 seconds was the value used during the compliance test. 

• The From URI and To URI entries for the REGISTER messages are built using the 

following:  

- From URI: Use the User Name entered above in the Authentication screen 

(user1234) and the service provider’s SIP Domain (avaya-test-domain.sip.1234.io), 

as shown in the screen below. This information should be provided by the service 

provider. 

- To URI: Use the User Name entered above in the Authentication screen (user1234) 

and the service provider’s SIP Domain (avaya-test-domain.sip.1234.io), as shown in 

the screen below. This information should be provided by the service provider. 

- Click Next (not shown). 

 

 
 

Click Next on the Add SIP Server Profile - Ping window (not shown). 
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On the Add SIP Server Profile – Advanced tab:  

• Uncheck Enable Grooming.  

• Select SP-General from the Interworking Profile drop-down menu (Section 7.4.2). 

• Click Finish. 
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The following screen capture shows the General tab of the newly created Service Provider 

UDP SIP Server Configuration Profile. 
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The following screen capture shows the Authentication tab of the newly created Service 

Provider UDP Server Configuration Profile. 

 

 
 

The following screen capture shows the Registration tab of the newly created Service Provider 

UDP Server Configuration Profile. 
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The following screen capture shows the Advanced tab of the newly created Service Provider 

UDP SIP Server Configuration Profile. 

 

 

7.5.1. Routing Profiles 

Routing profiles define a specific set of routing criteria that are used, in conjunction with other 

types of domain policies, to determine the route that SIP packets should follow to arrive at their 

intended destination. 

 

Two Routing profiles were created, one for inbound calls, with IP Office as the destination, and 

the second one for outbound calls, which are sent to the Service Provider SIP trunk. 

 

To create the inbound route, from the Configuration Profiles menu on the left-hand side (not 

shown):  

• Select Routing (not shown).  

• Click Add in the Routing Profiles section (not shown).  

• Enter Profile Name: Route_to_IPO_TLS. 

• Click Next.  
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On the Routing Profile screen complete the following: 

• Click on the Add button to add a Next-Hop Address. 

• Priority / Weight: 1 

• SIP Server Profile: Select IP Office Thornton. 

• Next Hop Address is populated automatically with 10.64.101.127:5061 (TLS) (IP Office 

IP address, Port and Transport).  

• Click Finish. 
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The following screen shows the newly created Route_to_IPO_TLS Routing Profile. 

 

 
 

Similarly, for the outbound route: 

• Select Routing (not shown).  

• Click Add in the Routing Profiles section (not shown).  

• Enter Profile Name: Route_to_SP_UDP. 

• Click Next.  
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On the Routing Profile screen complete the following: 

• Load Balancing: Select DNS/SRV. 

• Click on the Add button to add a Next-Hop Address. 

• Priority / Weight: 1 

• SIP Server Profile: Select Service Provider UDP. 

• The Next Hop Address is populated automatically with svc1234.us-east.test.trunk.io 

(UDP) (Avaya’s SIP Proxy FQDN and transport).  

• Click Finish. 
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The following screen capture shows the newly created Route_to_SP_UDP Routing Profile. 

 

 

7.5.2. Topology Hiding 

Topology Hiding is a security feature which allows changing several parameters of the SIP 

packets, preventing private enterprise network information from being propagated to the 

untrusted public network.  

 

Topology Hiding can also be used as an interoperability tool to adapt the host portion in SIP 

headers like To, From, Request-URI, Via, Record-Route and SDP to the IP addresses or domains 

expected by IP Office and the SIP trunk service provider, allowing the call to be accepted in each 

case.  

 

For the compliance test, only the minimum configuration required to achieve interoperability on 

the SIP trunk was performed. Additional steps can be taken in this section to further mask the 

information that is sent from the Enterprise to the public network. 

 

To add the Topology Hiding Profile in the Enterprise direction, select Topology Hiding from the 

Configuration Profiles menu on the left-hand side (not shown): 

• Click on default profile and select Clone Profile (not shown). 

• Enter the Profile Name: IP Office. 

• Click Finish. 
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The following screen capture shows the newly added IP Office Topology Hiding Profile. Note 

that for IP Office no values were overwritten (left with default values). 

 

 
 

To add the Topology Hiding Profile in the Service Provider direction, select Topology Hiding 

from the Configuration Profiles menu on the left-hand side (not shown): 

• Click on default profile and select Clone Profile (not shown). 

• Enter the Profile Name: Service_Provider. 

• Click Finish. 

 

 
 

• Click Edit on the newly created Service_Provider Topology Hiding profile. 

• On the From choose Overwrite from the pull-down menu under Replace Action, enter 

the domain name for the service provider (avaya-test-domain.sip.1234.io) under 

Overwrite Value 

• On the To choose Overwrite from the pull-down menu under Replace Action, enter the 

domain name for the service provider (avaya-test-domain.sip.1234.io) under Overwrite 

Value. 



 
HG; Reviewed: 

SPOC 10/20/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

83 of 115 

AvaIPO11SBC81U 

 

• On the Request-Line choose Overwrite from the pull-down menu under Replace 

Action, enter the domain name for the service provider (avaya-test-domain.sip.1234.io) 

under Overwrite Value. 

• Click Finish. 
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The following screen capture shows the newly added Service_Provider Topology Hiding 

Profile. 
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7.6. Domain Policies 

Domain Policies allow configuring, managing and applying various sets of rules designed to 

control and normalize the behavior of call flows, based upon various criteria of communication 

sessions originating from or terminating in the enterprise. 

7.6.1. Application Rules  

Application Rules defines which types of SIP-based Unified Communications (UC) applications 

the Avaya SBCE will protect: voice, video, and/or Instant Messaging (IM). In addition, 

Application Rules defines the maximum number of concurrent voice and video sessions the 

network will process in order to prevent resource exhaustion.  

 

From the menu on the left-hand side, select Domain Policies → Application Rules (not shown).  

• Click on the Add button to add a new rule (not shown). 

• Rule Name: enter the name of the profile, e.g., 500 Session. 

• Click Next.  
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• Under Audio check In and Out and set the Maximum Concurrent Sessions and 

Maximum Sessions Per Endpoint to recommended values; the value of 500 was used in 

the sample configuration. 

• Under Video check In and Out and set the Maximum Concurrent Sessions and 

Maximum Sessions Per Endpoint to recommended values; the value of 100 was used in 

the sample configuration. 

• Click Finish.  
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The following screen capture shows the newly created 500 Sessions Application Rule. 

 

 

7.6.2. Media Rules 

Media Rules allow one to define RTP media packet parameters such as prioritizing encryption 

techniques and packet encryption techniques. Together these media-related parameters define a 

strict profile that is associated with other SIP-specific policies to determine how media packets 

matching these criteria will be handled by the Avaya SBCE security product. For the compliance 

test one media rule was created toward IP Office, the existing default-low-med media rule was 

used toward the Service Provider. 

  

To add a media rule in the IP Office direction, from the menu on the left-hand side, select 

Domain Policies → Media Rules.  

• Click on the Add button to add a new media rule (not shown). 

• Under Rule Name enter IPO_SRTP. 

• Click Next. 
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• Under Audio Encryption, Preferred Format #1, select 

SRTP_AES_CM_128_HMAC_SHA1_80. 

• Under Audio Encryption, Preferred Format #2, select RTP. 

• Under Audio Encryption, uncheck Encrypted RTCP. 

• Under Audio Encryption, check Interworking. 

• Repeat the above steps under Video Encryption. 

• Under Miscellaneous check Capability Negotiation. 

• Click Next. 

 

 
 

• Accept default values in the remaining sections by clicking Next (not shown), and then 

click Finish (not shown). 

 



 
HG; Reviewed: 

SPOC 10/20/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

89 of 115 

AvaIPO11SBC81U 

 

The following screen capture shows the newly created IPO_SRTP Media Rule. 

 

 

7.6.3. End Point Policy Groups 

End Point Policy Groups are associations of different sets of rules (Media, Signaling, Security, 

etc.) to be applied to specific SIP messages traversing through the Avaya SBCE. 

 

To create an End Point Policy Group for the Enterprise, from the Domain Policies menu, select 

End Point Policy Groups (not shown).  

• Click on the Add button to add a new policy group (not shown). 

• Group Name: Enterprise. 

• Click Next. 

 

 
 



 
HG; Reviewed: 

SPOC 10/20/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

90 of 115 

AvaIPO11SBC81U 

 

• Application Rule: 500 Sessions.  

• Border Rule: default.  

• Media Rule: IPO_SRTP (Section 7.6.2).  

• Security Rule: default-low.  

• Signaling Rule: default. 

• Click Finish. 

 

 
 

The following screen capture shows the newly created Enterprise End Point Policy Group. 
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Similarly, to create an End Point Policy Group for the Service Provider SIP Trunk. 

• Click on the Add button to add a new policy group (not shown). 

• Group Name: Service Provider. 

• Click Next. 

 

 
 

• Application Rule: 500 Sessions 

• Border Rule: default.  

• Media Rule: default-low-med.  

• Security Rule: default-low.  

• Signaling Rule: default. 

• Click Finish. 
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The following screen capture shows the newly created Service Provider End Point Policy 

Group. 
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7.7. Network & Flows Settings 

The Network & Flows settings allow the management of various device-specific parameters, 

which determine how a particular device will function when deployed in the network. Specific 

server parameters, like network and interface settings, as well as call flows, etc. are defined here.  

7.7.1. Network Management 

The network information should have been previously completed. To verify the network 

configuration, from the Network & Flows on the left-hand side, select Network Management. 

Select the Networks tab. 

 

In the event that changes need to be made to the network configuration information, they can be 

entered here.  

 

Use Figure 1 as reference for IP address assignments. 

 

Note: Only the highlighted entity items were created for the compliance test and are the ones 

relevant to these Application Notes. Blurred out items are part of the Remote Worker 

configuration, which is not discussed in these Application Notes. 

 

 
 



 
HG; Reviewed: 

SPOC 10/20/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

94 of 115 

AvaIPO11SBC81U 

 

On the Interfaces tab, click the Status control for interfaces A1 and B1 to change the status to 

Enabled. It should be noted that the default state for all interfaces is Disabled, so it is important 

to perform this step, or the Avaya SBCE will not be able to communicate on any of its interfaces. 
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7.7.2. Media Interface 

Media Interfaces are created to specify the IP address and port range in which the Avaya SBCE 

will accept media streams on each interface. Packets leaving the interfaces of the Avaya SBCE 

will advertise this IP address, and one of the ports in this range as the listening IP address and 

port in which the SBCE will accept media from the connected server. Create a SIP Media 

Interface for both the inside and outside IP interfaces. On the Private and Public interfaces of the 

Avaya SBCE, the port range 35000 to 40000 was used. 

 

From the Network & Flows menu on the left-hand side, select Media Interface (not shown). 

• Select Add in the Media Interface area (not shown).  

• Name: Private_med. 

• Under IP Address select: Network_A1 (A1, VLAN 0) 

• Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBCE, toward IP 

Office).  

• Port Range: 35000-40000. 

• Click Finish. 
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Select Add in the Media Interface area (not shown).  

• Name: Public_med. 

• Under IP Address select: Network_B1 (B1, VLAN 0) 

• Select IP Address: 10.10.80.51 (Outside IP Address of the Avaya SBCE, toward the 

Service Provider). 

• Port Range: 35000-40000. 

• Click Finish. 

 

 
 

The following screen capture shows the newly created Media Interfaces. 
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7.7.3. Signaling Interface 

To create the Signaling Interface toward IP Office, from the Network & Flows menu on the left-

hand side, select Signaling Interface (not shown). 

• Select Add in the Signaling Interface area (not shown). 

• Name: Private_sig. 

• Under IP Address select: Network_A1 (A1, VLAN 0)  

• Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBCE, toward IP 

Office). 

• TLS Port: 5061.  

• Select a TLS Profile.  

• Click Finish. 
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• Select Add in the Signaling Interface area (not shown). 

• Name: Public_sig. 

• Under IP Address select: Network_B1 (B1, VLAN 0)  

• Select IP Address: 10.10.80.51 (outside or public IP Address of the Avaya SBCE, 

toward the Service Provider). 

• UDP Port: 5060.  

• Click Finish. 

 

 
 



 
HG; Reviewed: 

SPOC 10/20/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

99 of 115 

AvaIPO11SBC81U 

 

The following screen capture shows the newly created Signaling Interfaces. 

 

 

7.7.4. End Point Flows 

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URIs, etc.) 

is used to determine which flow it matches. Once the flow is determined, the flow points to a 

policy group which contains several rules concerning processing, privileges, authentication, 

routing, etc. Once routing is applied and the destination endpoint is determined, the policies for 

this destination endpoint are applied. The context is maintained, so as to be applied to future 

packets in the same flow. The following screen illustrates the flow through the Avaya SBCE to 

secure a SIP Trunk call. 
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The End-Point Flows define certain parameters that pertain to the signaling and media portions 

of a call, whether it originates from within the enterprise or outside of the enterprise. 

 

To create the call flow toward the Service Provider SIP trunk, from the Network & Flows menu, 

select End Point Flows (not shown), then the Server Flows tab. Click Add (not shown). 

• Name: SIP_Trunk_Flow_UDP. 

• Server Configuration: Service Provider UDP. 

• URI Group: *  

• Transport: *  

• Remote Subnet: *  

• Received Interface: Private_sig. 

• Signaling Interface: Public_sig.  

• Media Interface: Public_med. 

• Secondary Media Interface: None. 

• End Point Policy Group: Service Provider. 

• Routing Profile: Route_to_IPO_TLS (Note that this is the reverse route of the flow). 

• Topology Hiding Profile: Service_Provider. 

• Click Finish. 
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To create the call flow toward IP Office, click Add (not shown). 

• Name: IP_Office_Flow. 

• Server Configuration: IP Office-Thornton. 

• URI Group: *  

• Transport: *  

• Remote Subnet: *  

• Received Interface: Public_sig. 

• Signaling Interface: Private_sig.  

• Media Interface: Private_med. 

• Secondary Media Interface: None. 

• End Point Policy Group: Enterprise. 

• Routing Profile: Route_to_SP_UDP (Note that this is the reverse route of the flow). 

• Topology Hiding Profile: IP Office. 

• Click Finish. 
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The following screen capture shows the newly created End Point Flows. 
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8. Avaya SIP Trunking Service Configuration 
To use Avaya SIP Trunking Service, a customer must request the service from Avaya using the 

established sales processes. The process can be started by contacting Avaya via the corporate 

web site at: https://www.avaya.com/en/documents/fs-sip-uc8179en.pdf and requesting 

information. 

 

During the signup process, Avaya and the customer will discuss details about the preferred 

method to be used to connect the customer’s Avaya enterprise network to the Avaya SIP 

Trunking service network.  

 

Avaya will provide the following information: 

• SIP Proxy FQDN to be used for public DNS SRV record queries. 

• SIP domain name to be used. 

• SIP Trunk registration credentials (User Name, Password, etc.). 

• DID numbers. 

• Public DNS IP addresses. 

• Etc. 

https://www.avaya.com/en/documents/fs-sip-uc8179en.pdf
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9. Verification Steps 
This section provides verification steps that may be performed to verify that the solution is 

configured properly. 

 

The following steps may be used to verify the configuration: 

• Verify that endpoints at the enterprise site can place calls to the PSTN. 

• Verify that endpoints at the enterprise site can receive calls from the PSTN. 

• Verify that users at the PSTN can end active calls to endpoints at the enterprise by 

hanging up. 

• Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up. 

9.1. IP Office System Status 

The following steps can also be used to verify the configuration. 

 

Use the IP Office System Status application to verify the state of SIP connections. Launch the 

application from Start → Programs → IP Office → System Status on the PC where IP Office 

Manager is installed, log in with the proper credentials. 
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify 

the Current State is Idle for each channel. 
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9.2. Monitor 

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling 

messaging on the SIP trunk. Launch the application from Start → Programs → IP Office → 

Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the 

taskbar and Select the IP address of the IP Office system under verification.  

 

 
 

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the 

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the 

color used to represent the packets in the trace can be customized by right clicking on the type of 

packet and selecting the desired color. 
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9.3. Avaya Session Border Controller for Enterprise 

There are several links and menus located on the taskbar at the top of the screen of the web 

interface that can provide useful diagnostic or troubleshooting information. 
 

Alarms: Provides information about the health of the Avaya SBCE. 

 

 
 

The following screen shows the Alarm Viewer page. 
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Incidents: Provides detailed reports of anomalies, errors, policies violations, etc. 
 

 
 

The following screen shows the Incident Viewer page. 
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Status : Provides the status for each server resolved during DNS SRV queries handling calls 

to/from the PSTN. Note that Server FQDN and Server IP/Port were blurred out for security 

reasons. 
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Diagnostics: This screen provides a variety of tools to test and troubleshoot the Avaya SBCE 

network connectivity. 
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The following screen shows the Diagnostics page with the results of a ping test. 
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Additionally, the Avaya SBCE contains an internal packet capture tool that allows the capture of 

packets on any of its interfaces, saving them as pcap files. Navigate to Monitor & Logging → 

→ Trace. Select the Packet Capture tab, set the desired configuration for the trace and click 

Start Capture. 
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Once the capture is stopped, click on the Captures tab and select the proper pcap file. Note that 

the date and time is appended to the filename specified previously. The file can now be saved to 

the local PC, where it can be opened with an application such as Wireshark. 

 

 
 

Also, the traceSBC tool can be used to monitor the SIP signaling messages between the Service 

provider and the Avaya SBCE. 
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10. Conclusion 
These Application Notes describe the procedures required to configure Avaya IP Office Release 

11.1 and Avaya Session Border Controller for Enterprise Release 8.1 to interoperate with the 

Avaya SIP Trunking service, as shown in Figure 1.  

 

Interoperability testing was completed successfully with the observations/limitations outlined in 

the scope of testing in Section 2.1 as well as under test results in Section 2.2. 

11. Additional References  
This section references the documentation relevant to these Application Notes. Product 

documentation for Avaya IP Office, including the following, is available at: 

http://support.avaya.com/ 

 

[1] Deploying IP Office Platform Server Edition, Release 11.1, Issue 14, April 2020 

[2] IP Office Platform 11.1, Deploying Avaya IP Office Servers as Virtual Machines, August 

2020 

[3] Avaya IP Office Platform Server Edition Reference Configuration Release 11.1, Issue 2, May 

2020 

[4] IP Office Platform 11.1, Deploying an IP500 V2 IP Office Basic Edition System, Issue 36g, 

September 10, 2020 

[5] IP Office Platform 11.1, Deploying an IP500 V2 IP Office Essential Edition System, Issue 

36g, September 10, 2020 

[6] Administering Avaya IP Office Platform with Manager, Release 11.1 SP1, July 2020. 

[7] Administering Avaya IP Office Platform with Web Manager, Release 11.1 SP1, Issue 22, July 

2020. 

[8] Avaya IP Office Platform Feature Description, Release 11.1, Issue 2, May 2020. 

[9] Deploying Avaya Session Border Controller on a Virtualized Environment Platform, Release 

8.1, Issue 3, August 2020. 

[10] Administering Avaya Session Border Controller for Enterprise, Release 8.1.x, Issue 3, August 

2020. 

[11] Planning for and Administering Avaya IX ™ Workplace Client for Android, iOS, Mac and 

Windows, August 2020 

[12] Using Avaya Avaya IX ™ Workplace Client for Android, iOS, Mac and Windows, August 

2020 

 

Additional Avaya IP Office documentation can be found at: 

https://ipofficekb.avaya.com/ 

 

http://support.avaya.com/
https://ipofficekb.avaya.com/
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